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About this document 

Scope and purpose 

AN79953では、Arm® Cortex®-M0/M0+ベースのプログラム可能なシステムオンチップである PSoC™ 4につ
いてご紹介します。本資料は、開発者のお客様が PSoC™ 4アーキテクチャとその開発ツールを探究する
ために役立つほか、PSoC™ Creatorおよび ModusToolbox™という PSoC™ 4用の開発ツールを使用して新
規のプロジェクトを作成する際に有用な案内をご提供します。本アプリケーション ノートは PSoC™ 4の
徹底的な研究を促進するリソースもご提供します。 

Intended audience 

このアプリケーションノートは、PSoC™および ModusToolbox™を初めて使用するエンジニア、および組
込みマイクロコントローラーの使用経験があるエンジニアを対象とします。 

関連製品ファミリ 

すべての PSoC™ 4製品 

ソフトウェアバージョン 

PSoC™ Creator 4.3 SP2以降, ModusToolbox™ 2.3以降 

その他のサンプルコードが必要な場合は、以下を参照してください。 

PSoC™のサンプルコード リストにアクセスするためにはサンプルコード ウェブページをご覧くださ
い。 
ビデオ ライブラリについてはここからご覧ください。 
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1 はじめに 
PSoC™ 4デバイスは、単一のチップ上にカスタム アナログとデジタル ペリフェラル機能、メモリおよび
Arm® Cortex®-M0または Cortex®-M0+マイクロコントローラーを集積した、真のプログラマブル組込みシ
ステムオンチップです。 

このようなシステムは、マイクロコントローラー ユニット (MCU) と外付けアナログおよびデジタルペリ
フェラルの組合わせを使用するほとんどのミックスド シグナルの組込みシステムとは異なります。通
常、このようなシステムは MCUに加えて、オペアンプ、ADC、Application-specific Integrated Circuit 
(ASIC) など多くの集積回路が必要です。 

PSoC™ 4は、MCUと外部 ICの組み合わせに代わるものとして低コストなソリューションを提供します。
システム全体のコスト削減に加えて、プログラマブル アナログとデジタル サブシステムにより高い柔
軟性、設計のインフィールド チューニングおよび製品化までの時間縮小をご提供します。 

PSoC™ 4の CAPSENSE™ (静電容量タッチ センシング機能) は、比類のない信号対雑音比、クラス最高の耐
水性およびボタンやスライダー、トラック パッド、近接センサーなど多種多様なセンサー タイプを提
供します。PSoC™ 4は SRAM、プログラマブル ロジックおよび割込みからウェイクアップする機能を保
持しながら、クラス最高の低消費電流 150 nAを実現します。また、非保持の電力モードでウェイクアッ
プ機能を保持し、わずか 20 nAの消費電流です。PSoC™ 4ファミリ デバイスは、Bluetooth® Low Energy 
(Bluetooth® LE) 無線システムを搭載する PSoC™ 4 Bluetooth® LEも含んでいます。PSoC™ 4 Bluetooth® LE
の詳細については AN91267を参照してください。 

本ドキュメントを使用するにあたって 

この後の数ページでは、PSoC™ 4自身と、PSoC™、ModusToolbox™、および PSoC™ Creatorを使用して
設計する利点について説明します。スキップして簡単なデザインを作成する場合は、ModusToolbox™で
は ModusToolbox™を使用するはじめての PSoC™ 4設計に、PSoC™ Creatorでは PSoC™ Creatorを使用
するはじめての PSoC™ 4設計に進んでください。 

http://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
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2 PSoC™リソース 
ここで利用できる豊富なデータは、適切な PSoC™デバイスを選択し、デバイスを設計に迅速かつ効果的
に統合するのを支援します。以下は、PSoC™ 4リソースの要約です。 

• 概要: PSoC™ポートフォリオ、PSoC™ロードマップ 
• 製品セレクタ: PSoC™ 4。さらに、PSoC™ Creatorにはデバイス選択ツールを含みます。 
• データシートは、各ファミリの電気的仕様を掲載し説明します。 
• アプリケーション ノートは、基本的なレベルから高度なレベルまでの幅広いトピックに触れてお
り、以下のものが含まれます。 
− AN88619: PSoC™ 4 Hardware Design Considerations 
− AN73854: Introduction to Bootloaders 
− AN89610: Arm® Cortex® Code Optimization 
− AN86233: PSoC™ 4 Low-Power Modes and Power Reduction Techniques 
− AN57821: PSoC™ 3, PSoC™ 4 および PSoC™ 5LP のアナログ/デジタル混在回路基板レイアウトの注意
事項 

− AN89056: PSoC™ 4 – IEC 60730 Class B and IEC 61508 SIL Safety Software Library 
− AN64846: Getting Started with CAPSENSE™ 
− AN85951: PSoC™ 4および PSoC™ 6 MCU CAPSENSE™デザインガイド 

• サンプルコードは、製品の機能と使用法を示します。PSoC™ Creatorのサンプルコードと
ModusToolbox™のサンプルコードを参照してください。 

• テクニカル リファレンス マニュアル (TRM): 各 PSoC™ 4デバイス ファミリのアーキテクチャとレジ
スタの詳細な説明を掲載します。 

• PSoC™ 4 Programming Specificationは、PSoC™ 4不揮発性メモリのプログラムに必要な情報を提供
します。 

• 開発キット: 
− CY8CKIT-040, CY8CKIT-041, CY8CKIT-042, CY8CKIT-044, CY8CKIT-046, CY8CKIT-042-BLE, CY8CKIT-

045S, および CY8CKIT-041S-MAX PSoC™ 4 Pioneer Kitsは使いやすい安価な開発プラットフォームで
す。これらのキットには、Arduino準拠シールドおよび Digilent® Pmod™ドーター カードの専用コ
ネクタを搭載します。 

− CY8CKIT-043、CY8CKIT-145、CY8CKIT-147および CY8CKIT-149は PSoC™ 4デバイスをサンプリン
グするための低コスト プロトタイピング プラットフォームです。 

− MiniProg3または MiniProg4キットは、フラッシュプログラムとデバッグのためのインターフェー
スを提供します。 

− 統合開発環境 (IDE): PSoC™ 4を使用したアプリケーション開発に使用できる開発プラットフォーム
には、ModusToolbox™と PSoC™ Creatorの 2つがあります。 

− PSoC™ 4 CADライブラリは、一般的なツールのフットプリントと回路図のサポートを提供しま
す。 IBISモデルもご利用いただけます。 

• トレーニングビデオは、PSoC™ 4 101シリーズを含む幅広いトピックで利用できます。 
• Cypress Developer Communityは、世界中の仲間の PSoC™開発者との接続を 24時間年中無休で可能
にし、専用の PSoC™ 4 MCUコミュニティをホストします。 

2.1 ファームウェア/アプリケーション開発 
PSoC™ 4を使用したアプリケーション開発に使用できる開発プラットフォームは 2つあります。 

http://www.cypress.com/
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-platform-psoc-solutions-roadmap
http://www.cypress.com/products/psoc-4
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A1297
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A574&f%5B2%5D=field_related_products%3A1297
https://www.cypress.com/documentation/application-notes/an88619-psoc-4-hardware-design-considerations
https://www.cypress.com/documentation/application-notes/an73854-psoc-introduction-bootloaders
https://www.cypress.com/documentation/application-notes/an89610-psoc-4-and-psoc-5lp-arm-cortex-code-optimization
https://www.cypress.com/documentation/application-notes/an86233-psoc-4-low-power-modes-and-power-reduction-techniques
https://www.cypress.com/documentation/application-notes/an57821-psocr-3-psoc-4-and-psoc-5lp-mixed-signal-circuit-board
https://www.cypress.com/documentation/application-notes/an89056-psoc-4-iec-60730-class-b-and-iec-61508-sil-safety-software
https://www.cypress.com/documentation/application-notes/an64846-getting-started-capsense
https://www.cypress.com/documentation/application-notes/an85951-psoc-4-and-psoc-6-mcu-capsense-design-guide
https://www.cypress.com/search/all/code%20example?sort_by=search_api_relevance&f%5B0%5D=meta_type%3Asoftware_tools&f%5B1%5D=software_tools_meta_type%3A579&f%5B2%5D=field_related_products%3A1297
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&applicationID=0&l=0
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=field_related_products%3A1297&f%5B2%5D=resource_meta_type%3A108321
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=110&id=4749&applicationID=0&l=0
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-041-psoc-4-s-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-044-psoc-4-m-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/psoc-4500s-pioneer-kit-cy8ckit-045s
https://www.cypress.com/documentation/development-kitsboards/psoc-4500s-pioneer-kit-cy8ckit-045s
https://www.cypress.com/documentation/development-kitsboards/psoc-4100s-max-pioneer-kit-cy8ckit-041s-max
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-043-psoc-4-m-series-prototyping-kit
http://www.cypress.com/CY8CKIT-145
http://www.cypress.com/CY8CKIT-147
http://www.cypress.com/CY8CKIT-149
http://www.cypress.com/go/cy8ckit-002
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-005-miniprog4-program-and-debug-kit
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=field_related_products%3A1297&f%5B2%5D=resource_meta_type%3A1400
https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Asoftware_tools&f%5B1%5D=software_tools_meta_type%3A580&f%5B2%5D=field_related_products%3A1297
https://www.cypress.com/training/free-online-video-training-and-tutorials-cypress
https://www.cypress.com/training/psoc-101-video-tutorial-series-how-use-arm-cortex-m0-based-psoc-4
https://community.cypress.com/welcome
https://community.cypress.com/community/product-forums/MCU/psoc-4
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• ModusToolbox™: ModusToolbox™ソフトウェアには、構成ツール、低レベルドライバー、ミドルウェ
アライブラリ、オペレーティングシステムのサポート、および MCUとワイヤレスアプリケーション
の作成を可能にするその他のパッケージが含まれます。オプションの Eclipse IDEも含まれます。 

ModusToolbox™は、EclipseIDEから起動できるスタンドアロンのデバイスおよびミドルウェアコンフィ
ギュレーターをサポートします。コンフィギュレーターを使用して、デバイス内のさまざまなブロック
の構成を設定し、ファームウェア開発で使用できるコードを生成します。ModusToolbox™は、すべての
PSoC™ 6 MCUおよび最新の PSoC™ 4 MCUデバイスをサポートします。Table 1に、サポートされている
PSoC™ 4デバイスを示します。サポートされている PSoC™ 4デバイスのすべてのアプリケーション開発
には ModusToolbox™を使用することを推奨します。詳細については、ModusToolbox™のリソースを参
照してください。 

Table 1 ModusToolbox™でサポートされる PSoC™ 4デバイスのリスト 

デバイス 1 ModusToolbox™ PSoC™ Creator 
PSoC™ 4000S, PSoC™ 4100S, 
PSoC™ 4100S Plus, PSoC™ 4100S 
Plus 256K 

有 有 

PSoC™ 4100S Max 有 無 
他のすべての PSoC™ 4シリーズ 無 有 

 

ライブラリと有効化ソフトウェアは GitHubで入手できます。 

ModusToolbox™のツールとリソースもコマンドラインで使用できます。詳細なドキュメントについて
は、Running ModusToolbox™ from the command Lineを参照してください。 

• PSoC™ Creator: PSoC™ Creatorは無料の Windowsベースの IDEです。これにより PSoC™ 3、PSoC™ 
4、PSoC™ 5LP、および PSoC™ 6 MCUシステムのハードウェアとファームウェアの同時設計が可能に
なります。アプリケーションは、回路図キャプチャと 150を超える事前検証済みの本番環境対応の周
辺機器コンポーネントを使用して作成されます。 

                                                                    
1 完全な PSoC™ 4ポートフォリオについては、PSoC™ 4の機能セットを参照してください。 

https://github.com/cypresssemiconductorco
http://www.cypress.com/ModusToolboxCommandLine
http://www.cypress.com/psoccreator/?source=an79953
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2.2 IDEの選択 
Figure 1は、適切な IDEを選択するために役立ちます。 
 

Use PSoC Creator

Is device 
supported in 

ModusToolbox?

New PSoC 4 user

Use ModusToolbox

Is device 
supported only in 
ModusToolbox?

Do you need 
UDB-based Component in 

your Design?

Are you inclined towards using a 
Graphical Editor for Design Entry 

and Code Generation?

Recommended to use 
ModusToolbox

Yes

Yes

Yes

Yes

No

No

No

No

Do you need Linux or MacOS
 support or use third-party IDEs such 

as Visual Studio Code, IAR, or Arm 
MDK?

No

Yes

 

Figure 1 IDEの選択 
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2.2.1 ModusToolbox™を選ぶ理由 
• 包括的: 必要なリソースがあります。 
• 柔軟性: 独自のワークフローでリソースを使用できます。 
• アトミック：必要なリソースだけを取得できます。 
• GitHub上のコードリポジトリの大規模なコレクション。これには以下を含みます。 

− インフィニオンキットと連携したボードサポートパッケージ (BSP) 
− Hardware Abstruction Layer (HAL) や Peripheral Driver Library (PDL) などの低レベルのリソース 
− CAPSENSE™などの業界をリードする機能を可能にするミドルウェア 
− 徹底的にテストされたサンプルコードアプリケーションの広範なセット 

• Windows、Linux、および macOSプラットフォームに対応します。 
• IDEに依存せず、Visual Studio Code、Arm® MDK (μVision)、IAR Embedded Workbenchなどのサードパー
ティ IDEに対応します。 

• Eclipseベースのツールの使用経験があり、ModusToolbox™用のオプションの Eclipseベースの IDEの
機能と拡張性を利用したい場合は、ModusToolbox™を選択してください。 

2.3 ModusToolbox™のリソース 
ModusToolbox™は、統合された MCUおよびワイヤレスシステムを作成するための没入型開発経験を可能
にし、インフィニオンデバイスを既存の開発方式に統合できるようにするツールとソフトウェアのセッ
トです。 

ModusToolbox™用の Eclipse IDEは、アプリケーションの構成と開発をサポートするマルチプラットフォ
ーム開発環境です。ModusToolbox™インストーラーには、デザインコンフィギュレーターとツール、お
よびビルドシステムインフラストラクチャが含まれます。ビルドシステムインフラストラクチャには、
Eclipse IDE、メイクインフラストラクチャ、およびその他のツールから独立して実行できる新しいプロ
ジェクト作成ウィザードが含まれます。 

2.3.1 PSoC™ 4ソフトウェアリソース 
ModusToolbox™には、GitHubを介して配信されるサイプレスが提供するソフトウェアリソースも含みま
す。これらには以下が含まれます。 

• BSP – BSPは、ボード固有のドライバーおよびその他の機能を含むファームウェアのレイヤーです。
BSPは、ボードを初期化し、ボードレベルの周辺機器へのアクセスを提供する APIを提供するライブ
ラリのセットです。これには、PSoC™ 4用の PDLライブラリなどの低レベルのリソースが含まれ、ボ
ード周辺機器用のマクロがあります。カスタム BSPを作成して、エンドアプリケーションボードの
サポートを有効にできます。詳細については、ModusToolbox™ Library Managerユーザーガイドを
参照してください。 

• HAL – HALは、インフィニオン MCUでハードウェアブロックを構成および使用するための高レベルの
インターフェースを提供します。これは、複数の製品ファミリで使用できる汎用インターフェースで
す。使いやすさと移植性に重点を置いているということは、HALがすべての低レベルの周辺機能を公
開しているわけではないことを意味します。HALは、低レベルのドライバー (PSoC™ 4 PDLなど) を同
梱し、MCUへの高レベルのインターフェースを提供します。インターフェースは、任意の MCUで動
作するように抽象化されています。これは、ターゲット MCUから独立したアプリケーションファー
ムウェアを作成するために役立ちます。 

• HALは、単一のアプリケーション内でプラットフォーム固有のライブラリ (PSoC™ 4 PDLなど) と組み
合わせられます。ある部分でよりきめ細かい制御が必要な場合でも、ほとんどのアプリケーションで
HALのよりシンプルで汎用的なインターフェースを活用できます。 

https://github.com/cypresssemiconductorco
https://github.com/cypresssemiconductorco
https://www.cypress.com/file/520271/download


  

Application Note 8 of 64 001-89249 Rev. *J  
  2021-12-23 

PSoC™ 4入門 
  
PSoC™リソース 

  

• PSoC™ 4 PDL – PDLは、デバイスヘッダーファイル、スタートアップコード、および周辺機器ドライ
バーを 1つのパッケージに統合します。PDLは、PSoC™ 4デバイスファミリに対応します。ドライバ
ーは、ハードウェア機能を一連の使いやすい APIに抽象化します。これらは、PDL APIリファレンス
に完全に文書化されています。 

• PDLは、レジスタの使用法とビット構造を理解する必要性を減らし、PSoC™ 4シリーズの広範な周辺
機器セットのソフトウェア開発を容易にします。アプリケーションのドライバーを構成してから、
API呼び出しを使用して周辺機器を初期化して使用します。 

• アプリケーションに特定の機能を提供する広範なミドルウェアライブラリ。利用可能なミドルウェ
アは、接続 (Bluetooth®、AWS IoT、Bluetooth® LE、セキュアソケット) から PSoC™固有の機能 
(CAPSENSE™) にまたがります。ミドルウェアは、GitHubリポジトリを介してライブラリとして提供
されます。 

• ユーティリティ、Makefile、スクリプト、およびその他の構成ソフトウェア。 

2.3.2 コンフィギュレーター 
ModusToolbox™は、ハードウェアブロックの構成を容易にするコンフィギュレーターと呼ばれるグラフ
ィカルアプリケーションを提供します。たとえば、ドキュメントを検索してシリアル通信ブロック 
(SCB) を目的の構成の UARTとして構成する代わりに、適切なコンフィギュレーターを開き、ボーレー
ト、パリティ、およびストップビットを設定します。ハードウェア構成を保存すると、ツールは「C」
コードを生成して、ハードウェアを目的の構成で初期化します。 

コンフィギュレーターは互いに独立していますが、一緒に使用して柔軟な構成オプションを提供できま
す。これらは、スタンドアロンとして、他のツールと組み合わせて使用することも、Eclipse IDEからの
起動もできます。コンフィギュレーターは次の目的で使用されます。 

• オプションを設定し、ドライバーを構成するためのコードを生成する 
• 周辺機器のピンやクロックなどの接続を設定する 
• ミドルウェアを構成するためのオプションの設定とコードの生成 

PSoC™ 4アプリケーションの場合、使用可能なコンフィギュレーターは次のとおりです。 

• DeviceConfigurator: システム (プラットフォーム) 機能と基本的な周辺機器 (UART、タイマー、PWM
など) をセットアップします。 

• CAPSENSE™ Configuratorおよび Tuner: CAPSENSE™を構成し、必要なコードを生成します。 
• Smart I/O Configurator: スマート I/Oを構成します。 

これらの各コンフィギュレーターは独自のファイルを作成します (例えば、CAPSENSE™の場合は
design.cycapsense)。コンフィギュレータファイル (design.modusまたは design.cycapsense) は通常、BSP
で提供されます。BSPに基づいてアプリケーションが作成されると、ファイルがアプリケーションにコ
ピーされます。アプリケーション用のカスタムデバイスコンフィギュレータファイルを作成し、BSPに
よって提供されるファイルの上書きもできます。詳細については、ModusToolbox™のヘルプを参照して
ください。 

2.3.3 PSoC™ 4のソフトウェア開発 
PSoC™ 4デバイスのソフトウェア開発を可能にするために、重要なソースコードとツールが提供されま
す。ツールを使用して、ハードウェアの構成方法を指定したり、ファームウェアで使用できるコードを
生成したり、追加機能のために CAPSENSE™などのさまざまなミドルウェアライブラリを組み込んだり
できます。このソースコードにより、サポートされているデバイスのファームウェアの開発が容易にな
ります。レジスタセットを理解しなくても、ファームウェアをすばやくカスタマイズしてビルドするた
めに役立ちます。 

https://github.com/Infineon/modustoolbox-software
https://github.com/Infineon/modustoolbox-software
https://github.com/cypresssemiconductorco
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ModusToolbox™環境では、コンフィギュレーターを使用して、デバイスまたは CAPSENSE™機能などのミ
ドルウェアライブラリを構成できます。 

ドライバーコードは、mtb-pdl-cat2ライブラリとして提供されます。ミドルウェアは、機能ごとに個別
のライブラリとして提供されます。 

Eclipse IDE、サードパーティ IDE、またはコマンドラインのいずれを使用しているかに関係なく、レジス
タレベルで作業している場合は、PDLのドライバーソースコードを参照してください。PDLには、プロ
ジェクトに必要なすべてのデバイス固有のヘッダーファイルとスタートアップコードが含まれます。ま
た、各ドライバーのリファレンスとしても機能します。PDLはソースコードとして提供されるため、レ
ジスタレベルでハードウェアにアクセスする方法を確認できます。 

一部のデバイスは特定の周辺機器をサポートしていません。PDLは、サポートされているデバイスのす
べてのドライバーのスーパーセットです。このスーパーセットの設計は、以下のことを意味します。 

• 周辺機器の初期化、構成、および使用に必要なすべての API要素が利用可能です。 
• PDLは、使用可能な周辺機器に関係なく、さまざまな PSoC™ 4デバイスで役立ちます。 
• PDLには、ターゲットの周辺機器が選択したデバイスに存在することを確認するためのエラーチェッ
クを含みます。 

これにより、周辺機器が利用可能である限り、コードは PSoC™ 4デバイスファミリ全体で互換性を維持
できます。デバイスヘッダーファイルは、デバイスで使用可能な周辺機器を指定します。コードがサポ
ートされていないペリフェラルを使用しようとすると、コンパイル中にエラーが発生します。コードを
記述する前に、デバイスのデータシートを参照して、周辺機器がサポートされているかどうかを確認し
てください。 

Figure 2に、ModusToolbox™用の Eclipse IDEを使用して以下のことができることを示します。 

1. Project Creator (File > New > ModusToolbox Application) を使用して、BSP (キット) 用の新しいアプリ
ケーションを作成します。 

2. 構成ツールを使用して周辺機器とミドルウェアライブラリを構成します。 
3. ライブラリマネージャーを使用して、ライブラリと BSPを簡単かつ迅速に追加、更新、または削除
します。 

4. オプションで、Eclipseベースの IDEでコードを開発します。 
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Figure 2 ModusToolbox™リソースおよびミドルウェア用の Eclipse IDE 

2.3.4 サンプルコード 
Project Creatorツールは、ModusToolbox™ソフトウェアとともに使用され、BSPとサンプルコードに基
づいてアプリケーションを作成します。Project Creatorは、任意のソフトウェア環境で使用できるアプ
リケーションを作成するためのグラフィカルユーザーインターフェース (GUI) およびコマンドラインイ
ンターフェース (CLI) として提供されます。 

1. プロジェクトクリエーターツールを開いてください。 

メニューの File > New > ModusToolbox Applicationに従ってください。 
 

 

Figure 3 プロジェクトクリエーターツールを開く 
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2. ターゲットの PSoC™ 4開発キットを選択してください。 

Choose Board Support Package (BSP) ダイアログで、リストからキットを選択してください。 
 

 

Figure 4 ターゲットハードウェアを選択 

3. アプリケーションを選択してください。 

Select Applicationダイアログには、選択した BSPに適用可能な Applicationが一覧表示されます。必要
なアプリケーションを選択し、Createをクリックしてください。選択したアプリケーションが作成され
ます。 
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Figure 5 アプリケーションを選択 

2.3.5 ModusToolbox™のヘルプ 
ModusToolbox™ user guideは、ModusToolbox™ソフトウェアの高レベルの概要を提供します。 

ModusToolbox™の最新バージョンをダウンロードしてインストールしてください。ModusToolbox™用の
Eclipse IDEを起動し、Help > ModusToolbox General Documentationと操作してください。 

• User Guide: アプリケーションの構築、プログラミング、およびデバッグの側面について説明しま
す。また、IDEとともにインストールされるツールのさまざまな側面についても説明します。 

• ModusToolbox Documentation Index: ModusToolbox™ソフトウェアに含まれるさまざまなドキュメン
トへの簡単な説明とリンクを提供します。 

Release Note: ModusToolbox™の対応するリリースの機能について説明し、知っておくべき既知の問題、
回避策、および設計への影響を示します。ModusToolbox™用の Eclipse IDEに関するドキュメントについ
ては、Help > Eclipse IDE for ModusToolbox Documentationと操作してください。 

• Quick Start Guide: ModusToolbox™用の Eclipse IDEを使用するための基本を提供します。 
• User Guide: Eclipse IDEを使用してアプリケーションを作成し、それらをビルド、プログラミング、お
よびデバッグする方法について説明します。 

• Eclipse IDE Survival Guide: Eclipse IDEの使用中に発生する可能性のある一般的な問題への回答を提供
します。ほとんどの質問は、ModusToolbox™ではなく Eclipse IDEに関連します。 

https://www.cypress.com/file/492951/download
http://www.cypress.com/modustoolbox
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2.4 PSoC™ Creator 
PSoC™ Creatorは、PSoC™システムのハードウェアとファームウェアの同時編集、コンパイル、および
デバッグを可能にする IDEです。Figure 6に示すように、PSoC™ Creatorを使用すると、以下のことがで
きます。 

1. コンポーネントをドラッグ&ドロップして、ハードウェア システム設計の構築 
2. アプリケーションのファームウェアと PSoC™ハードウェアの共同設計 
3. コンフィギュレーション ツールを使ったコンポーネントの構成 
4. 100以上のコンポーネントを含むライブラリの利用 
5. コンポーネント データシートの閲覧 
 

1

2
3

4

5

 

Figure 6 PSoC™ Creatorの特長 

2.4.1 サンプルコード 
PSoC™ Creatorは多数のサンプルコード プロジェクトを提供します。これらのプロジェクトは、Figure 7
に示すように、PSoC™ Creatorのスタート ページからアクセスできます。 

http://www.cypress.com/psoccreator/?source=an79953
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Figure 7 PSoC™ Creatorサンプルコード 

サンプルプロジェクトは、空のページの代わりに完了した設計で始まり設計時間を短縮でき、PSoC™ 
Creator Componentsが様々な用途にどのように利用できるかを示します。Figure 8に示すようにサンプ
ルコードおよびデータシートを含みます。 

Figure 8に示す Find Example Projectダイアログで、以下のことができます。 

a) アーキテクチャまたはデバイス ファミリ (PSoC™ 3、PSoC™ 4、PSoC™ 5LP、または PSoC™ 6 MCU) ま
たはカテゴリやキーワードに基づいてサンプルをフィルタします。 

b) フィルタリングされたサンプルリストから選択します。 
c) 選択したデータシートをレビューします (Documentationタブ)。 
d) 選択したサンプルコードをレビューします。このウィンドウからコードをコピーしてプロジェクト
に貼り付けると、コード開発の時間短縮ができます。または、選択したものに基づいて新規プロジ
ェクト (または必要に応じて新規ワークスペース) も作成できます。これにより、完成した基本的設
計から開始することで設計プロセスを時間短縮できます。その後、その設計を所望のアプリケーシ
ョンに適用できます。 
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Figure 8 サンプルコードのあるサンプルコードプロジェクト 

2.4.2 PSoC™ Creatorヘルプ 
PSoC™ Creatorホームページへアクセスし、PSoC™ Creatorの最新版をダウンロードしてください。次
に、PSoC™ Creatorを起動し、以下の項目へ操作してください。 

• Quick Start Guide (クイック スタート ガイド): Help > Documentation > Quick Start Guideを選択しま
す。このガイドは PSoC™ Creatorプロジェクトを開発するための基礎を提供します。 

• Simple Component example project: File > Open > Example projectsを選択します。これらのサンプル
プロジェクトは PSoC™ Creatorコンポーネントの設定と使用方法を示します。 

• System Reference Guide: Help > System Reference > System Reference Guideを選択します。このガイ
ドは PSoC™ Creatorにより提供されるシステム機能を一覧で説明します。 

• Component datasheet: コンポーネントを右クリックして Open Datasheetを選択します。すべての
PSoC™ 4コンポーネント データシートの一覧は、PSoC™ 4 Component datasheetsページに掲載され
ています。 

• PSoC™ Creator Training Video: これらの動画は PSoC™ Creator入門のステップ バイ ステップ方法を提
供します。 

• Document Manager: PSoC™ Creatorが提供するドキュメント マネージャーにより、ドキュメント リソ
ースを容易に検索し、確認できます。ドキュメント マネージャーを開くためには、メニューアイテ
ムの Help > Document Managerを選択します。 

http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4749&source=an79953
http://www.cypress.com/video-library/PSoC-Software
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2.5 テクニカル サポート 
ご質問については弊社のテクニカル サポート チームが対応します。テクニカルサポートページでサポ
ートリクエストを作成できます。サポートチームは、GitHubリポジトリに投稿された質問、問題、バグ
レポートを確認して対応します。 

緊急サポートが必要な場合は、以下のサポート リソースを利用してください。 

• セルフ ヘルプ 
• 各地の販売代理店 

https://www.cypress.com/support
https://github.com/cypresssemiconductorco
http://www.cypress.com/support
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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3 PSoC™ 4の機能セット 
PSoC™ 4は Figure 9に示すように、CPUとメモリ サブシステム、デジタル サブシステム、アナログ サ
ブシステム、システム リソースを含む幅広い機能を備えます。次の節は各機能について簡単に説明しま
す。詳細については、PSoC™ 4ファミリのデバイス データシート、テクニカル リファレンス マニュア
ル (TRM) および PSoC™リソースにリストアップされたアプリケーション ノートを参照してください。 
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Figure 9 PSoC™ 4アーキテクチャ (PSoC™ 4100S Max) 

PSoC™ 4ポートフォリオは、Arm® CM0および CM0+マイクロコントローラーのいくつかのファミリで構
成されます。ポートフォリオ内のほとんどのデバイスには、静電容量センシングアプリケーション用の
CAPSENSE™テクノロジーが搭載されます。PSoC™ 4ポートフォリオの他の主要な機能には、プログラム
可能なアナログブロックを介したカスタマイズ可能なアナログフロントエンドと、USB、コントローラ
ーエリアネットワーク (CAN)、Bluetooth® LEなどの有線および無線接続オプションが含まれます。これ
らの独自の機能により、PSoC™ 4は業界で最も柔軟でスケーラブルな低電力ミックスドシグナルアーキ
テクチャを実現しました。PSoC™ 4デバイスは、Table 2に示すように、さまざまな機能に基づいてさま
ざまなファミリに分類されます。 
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Table 2 PSoC™ 4ファミリ 

分類 ファミリ 特長 詳細 
入門レベル PSoC™ 4000ファミリ CAPSENSE™ Table 3 
インテリジェント 
アナログ PSoC™ 4100ファミリ CAPSENSE™ + プログラム可能なアナログ Table 4 

プログラム可能な 
デジタル PSoC™ 4200ファミリ CAPSENSE™ + プログラム可能なアナログ + 

プログラム可能なデジタルブロック Table 5 

特定用途向け 
PSoC™ 4500ファミリ CAPSENSE™ + モーター制御 

Table 6 
PSoC™ 4700ファミリ CAPSENSE™ + Inductive Sensing 

アナログ 
コプロセッサ 2 PSoC™ 4A00ファミリ 

CAPSENSE™ + プログラム可能なアナログ
ブロック AN211293 

 

Note: Table 3および Table 4で、青色で強調表示されている列のファミリは ModusToolbox™でサ
ポートされていることを示します。 

Table 3 PSoC™ 4000ファミリの特長 

特長 PSoC™ 4000 PSoC™ 4000S 
CPU 16 MHz Cortex®-M0 48 MHz Cortex®-M0+ 
フラッシュメモリ 16 KB 32 KB 
SRAM 2 KB 4 KB 
GPIO 20 36 
CAPSENSE™ 16 センサー 35 センサー 
シングルスロープ ADC  
(10 ビット 46 ksps) 

なし 1 

コンパレータ 固定閾値の 1 つの CSD コンパレ

ータ (1.2 V) 
ウェイクアップ機能付き 2 つの低電力コン

パレータ 
IDAC 3 1 つの 7 ビットと 1 つの 8 ビット 2 つの 7 ビット 
スマート I/O ポート なし 2 
電源電圧範囲 1.71 V ～ 5.5 V 1.71 V ～ 5.5 V 
低消費電力モード 2.5 µA でのディープスリープ 2.5 µA でのディープスリープ 
セグメント LCD 駆動 なし 4 COM セグメント LCD 駆動 
シリアル通信 1 つの I2C プログラム可能な I2C, SPI, または UART を

備えた 2 つの SCB 
タイマーカウンター 
パルス幅変調器 (TCPWM) 

1 5 

クロック 内部メイン 
発振器 (IMO) 

24 MHz/32 MHz 24 MHz ～ 48 MHz 

内部低速 
発振器 (ILO) 

32 kHz 内部 ILO 40 kHz 

                                                                    
2 PSoC™ 4アナログコプロセッサファミリデバイスの使用を開始するためには、AN211293を参照してください。 
3 IDACは、CAPSENSE™を使用しない場合にのみ利用可能です。詳細は、各 PSoC™ 4アーキテクチャ TRMを参照してください。 

https://www.cypress.com/documentation/application-notes/an211293-getting-started-psoc-analog-coprocessor
https://www.cypress.com/documentation/application-notes/an211293-getting-started-psoc-analog-coprocessor
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特長 PSoC™ 4000 PSoC™ 4000S 
時計水晶 
発振器 (WCO) 

なし 32 kHz 

電源監視 パワーオンリセット (POR) 
電圧低下検出 (BOD) POR, BOD 

対応するキット CY8CKIT-040 Pioneer kit CY8CKIT-041 Pioneer kit 
対応する IDE PSoC™ Creator PSoC™ Creator, ModusToolbox™ 

 

http://www.cypress.com/CY8CKIT-040&source=an79953
http://www.cypress.com/CY8CKIT-041
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/modustoolbox-software-environment
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Table 4 PSoC™ 4100ファミリの特長 

特長 PSoC™ 4100 PSoC™ 4100S PSoC™ 4100S 
Plus 

PSoC™ 4100S 
Plus 256K 

PSoC™ 4100
PS 

PSoC™ 4100
M 

PSoC™ 4100 
BL4 

PSoC™ 4100
S Max 

CPU 24 MHz 
Cortex®-M0 

48 MHz 
Cortex®-M0+ 

48 MHz 
Cortex®-M0+ 

48 MHz 
Cortex®-M0+ 

48 MHz  
Cortex®-M0+ 

24 MHz 
Cortex®-M0 

24-MHz 
Cortex®-M0 

48 MHz 
Cortex®-M0+ 

DMA 該当なし 該当なし 8チャネル 8チャネル 8チャネル 8チャネル 8チャネル 16チャネル 
フラッシュメモリ 32 KB 64 KB 128 KB 256 KB 32 KB 128 KB 256 KB 384 KB 
SRAM 4 KB 8 KB 16 KB 32 KB 4 KB 16 KB 32 kB 32 KB 
GPIO 36 36 54 54 38 55 36 84 
CAPSENSE™ 1チャネル, 

35センサー 
1チャネル,  
35センサー 

1チャネル, 53
センサー 

1チャネル, 53
センサー 

1チャネル,  
33センサー 

2チャネル, 
54センサー 

1チャネル,  
35センサー 

2チャネル,  
80センサー 
(32 control 
mux) 

シーケンサ付き 12
ビット SAR ADC 

806 KSPS 1 MSPS  1 MSPS 1 MSPS 1 MSPS 806 KSPS 806 KSPS 1 MSPS 

オペアンプ (プログ
ラム可能)  

2 2 2 2 4/PGA 4 2 2 

プログラム可能電
圧リファレンス 
(PVref) 

なし なし なし なし 4チャネル なし なし なし 

電圧 DAC (VDAC) なし なし なし なし 2つの 13ビ
ット VDAC 

なし なし なし 

コンパレータ  
(ウェイクアップ機
能付き低電力) 

2 2 2 2 2 2 2 2 

IDAC5 1つの 7ビッ
トと 1つの 8
ビット 

2つの 7ビッ
ト 

2つの 7ビッ
ト 

2つの 7ビッ
ト 

2つの 7ビ
ット 

2つの 7ビ
ットと 2つ
の 8ビット 

1つの 7ビ
ットと 1つ
の 8ビット 

なし 

                                                                    
4 PSoC™ 4 Bluetooth® LEファミリデバイスの使用を開始するためには、AN91267を参照してください。 

5 IDACは、CAPSENSE™を使用しない場合にのみ利用可能です。詳細は、各 PSoC™ 4アーキテクチャ TRMを参照してください。 

https://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
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特長 PSoC™ 4100 PSoC™ 4100S PSoC™ 4100S 
Plus 

PSoC™ 4100S 
Plus 256K 

PSoC™ 4100
PS 

PSoC™ 4100
M 

PSoC™ 4100 
BL4 

PSoC™ 4100
S Max 

スマート I/Oポー
ト 

なし 2 3 2 1 なし なし 3 

電源電圧範囲 1.71 V～5.5 V 1.71 V～5.5 V 1.71 V～5.5 V 1.71 V～5.5 V 1.71 V～
5.5 V 

1.71 V～
5.5 V 

1.71 V～
5.5 V 

1.71 V～
5.5 V 

低消費
電力 
モード 

ディープ
スリープ 

1.3 µA 2.5 µA 2.5 µA 2.5 µA 2.5 µA 1.35 µA 2.5 µA 2.5 µA 

ハイバネ
ート 

150 nA 該当なし 該当なし 該当なし 該当なし 150 nA 該当なし 該当なし 

ストップ 20 nA 該当なし 該当なし 該当なし 該当なし 35 nA 該当なし 該当なし 
セグメント LCD駆
動 

4 COM 4 COM 4 COM 4 COM 4 COM 4 COM 4 COM 4 COM 

プログラム可能な
I2C, SPI, または
UARTを備えた SCB 

2 3 5 5 3 4 2 5 

TCPWM 4 5 8 8 8 8 4 8 
CAN なし なし 1 なし なし なし なし 1 
Bluetooth® LE なし なし なし なし なし なし 4.1/4.2 なし 
クロッ
ク 

IMO 3 MHz～ 
24 MHz 

24 MHz～ 
48 MHz 

24 MHz～ 
48 MHz 

24 MHz～ 
48 MHz 

24 MHz～ 
48 MHz 

3 MHz～ 
48 MHz 

24 MHz～ 
48 MHz 

24 MHz～ 
48 MHz 

ILO 32 kHz 40 kHz 40 kHz 40 kHz 40 kHz 32 kHz 40 kHz 40 kHz 
WCO Nil 32 kHZ 32 kHZ 32 kHZ 32 kHZ 32 kHZ 32 kHZ 32 kHZ 

電源監視 POR, BOD, 低
電圧検知 
(LVD) 

POR, BOD POR, BOD POR, BOD POR, BOD POR, BOD, 
LVD 

POR, BOD, 
LVD 

POR, BOD 

対応するキット CY8CKIT-049 
prototyping 
kit 

CY8CKIT-041 
pioneer kit 

CY8CKIT-149 
prototyping 
kit 

- CY8CKIT-
147 
prototyping 
kit 

CY8CKIT-
044 pioneer 
kit 

CY8CKIT-
042 
Bluetooth® 
LE pioneer 
kit 

CY8CKIT-
041S-MAX 
pioneer kit 

http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/?rID=92146&source=an79953
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-041-41xx-psoc-4100s-capsense-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-041-41xx-psoc-4100s-capsense-pioneer-kit
http://www.cypress.com/cy8ckit-149
http://www.cypress.com/cy8ckit-149
http://www.cypress.com/cy8ckit-149
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-147-psoc-4100ps-prototyping-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-147-psoc-4100ps-prototyping-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-147-psoc-4100ps-prototyping-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-147-psoc-4100ps-prototyping-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-044-psoc-4-m-series-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-044-psoc-4-m-series-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-044-psoc-4-m-series-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/psoc-4100s-max-pioneer-kit-cy8ckit-041s-max
https://www.cypress.com/documentation/development-kitsboards/psoc-4100s-max-pioneer-kit-cy8ckit-041s-max
https://www.cypress.com/documentation/development-kitsboards/psoc-4100s-max-pioneer-kit-cy8ckit-041s-max
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特長 PSoC™ 4100 PSoC™ 4100S PSoC™ 4100S 
Plus 

PSoC™ 4100S 
Plus 256K 

PSoC™ 4100
PS 

PSoC™ 4100
M 

PSoC™ 4100 
BL4 

PSoC™ 4100
S Max 

対応する IDE PSoC™ 
Creator 

PSoC™ 
Creator, 
ModusToolbox
™ 

PSoC™ 
Creator, 
ModusToolbox
™ 

PSoC™ 
Creator, 
ModusToolbox
™ 

PSoC™ 
Creator 

PSoC™ 
Creator 

PSoC™ 
Creator 

ModusToolb
ox™ 

 

https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/modustoolbox-software-environment
https://www.cypress.com/products/modustoolbox-software-environment
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Table 5 PSoC™ 4200ファミリの特長 

特長 PSoC™ 4200 PSoC™ 4200DS PSoC™ 4200M PSoC™ 4200L PSoC™ 4200 BL6 
CM0 CPU 48 MHz 

Cortex®-M0 
48 MHz 
Cortex®-M0 

48 MHz 
Cortex®-M0 

48 MHz 
Cortex®-M0 

48 MHz 
Cortex®-M0 

DMA なし 8チャネル 8チャネル 32チャネル なし 
フラッシュメモリ 32 KB 64 KB 128 KB 256 KB 256 KB 
SRAM 4 KB 8 KB 16 KB 32 KB 32 KB 
GPIO 36 21 55 96  36 
CAPSENSE™ 1チャネル, 

35センサー 
なし 2チャネル, 

54センサー 
2チャネル, 
94センサー 

1チャネル, 35
センサー 

ADC (12ビット, シー
ケンサ付き 1 MSPS 
SAR ADC) 

1 なし 1 1 1 

オペアンプ (プログラ
ム可能)  

2 なし 2 4 2 

コンパレータ (ウェイ
クアップ機能付き低
電力) 

2 2 2 2 2 

IDAC7 1つの 7ビ
ットと 1つ
の 8ビット 

なし 2つの 7ビッ
トと 2つの 8
ビット 

2つの 7ビッ
トと 2つの 8
ビット 

1つの 7ビッ
トと 1つの 8
ビット 

プログラム可能論理
ブロック (UDB) 

4 4 4 8 4 

スマート I/Oポート なし 1 なし なし なし 
電源電圧範囲 1.71 V～ 

5.5 V 
1.71 V～5.5 V 1.71 V～5.5 V 1.71 V～5.5 V 1.71 V～5.5 V 

低消費電
力モード 

ディープ
スリープ 

1.3 µA 2 µA 1.3 µA 1.3 µA 1.5 µA 

ハイバネ
ート 

150 nA 該当なし 150 nA 150 nA 150 nA 

ストップ 20 nA 該当なし 20 nA 20 nA 20 nA 
セグメント LCD駆動 4 COM なし 4 COM 8 COM 4 COM 
プログラム可能 I2C, 
SPI, または UART付き
SCB 

2 3 4 4 2 

TCPWM 4 4 8 8 4 
CAN なし なし 2 2 なし 
Bluetooth® LE なし なし なし なし 4.1/4.2 

                                                                    
6 PSoC™ 4 Bluetooth® LEファミリデバイスの使用を開始するためには、AN91267を参照してください。 

7 IDACは、CAPSENSE™を使用しない場合にのみ利用可能です。詳細は、各 PSoC™ 4アーキテクチャ TRMを参照してください。 

https://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
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特長 PSoC™ 4200 PSoC™ 4200DS PSoC™ 4200M PSoC™ 4200L PSoC™ 4200 BL6 
USBフルスピードデ
バイスコントローラ 
(USB) 

なし なし なし あり なし 

クロック IMO 3 MHz～ 
48 MHz 

3 MHz～ 
48 MHz 

3 MHz～ 
48 MHz 

3 MHz～ 
48 MHz 

3 MHz～ 
48 MHz 

ILO 32 kHz 40 kHz 32 kHz 32 kHz 32 kHz 
WCO なし なし 32 kHz 32 kHz 32 kHz 
外部水晶
発振器 
(ECO) 

なし なし 4 MHz～ 
33 MHz 

なし なし 

電源監視 POR, BOD, 
LVD 

POR, BOD POR, BOD, 
LVD 

POR, BOD, 
LVD 

POR, BOD, LVD 

対応するキット CY8CKIT-
042 pioneer 
kit  

CY8CKIT-146 
prototyping 
kit 

CY8CKIT-044 
pioneer kit 

CY8CKIT-046 
pioneer kit 

CY8CKIT-042 
Bluetooth® LE 
pioneer kit 

対応する IDE PSoC™ 
Creator 

PSoC™ 
Creator 

PSoC™ 
Creator 

PSoC™ 
Creator 

PSoC™ Creator 

Table 6 PSoC™ 4500および PSoC™ 4700ファミリの特長 

特長 PSoC™ 4500S PSoC™ 4700S 
CM0+ CPU 48 MHz Cortex®-M0+ 48 MHz Cortex®-M0+ 
DMA 8チャネル なし 
フラッシュメモリ 256 KB 32 KB 
SRAM 32 KB 4 KB 
GPIO 53 36 
CAPSENSE™ 1チャネル, 52センサー 1チャネル, 35センサー 
MagSense なし 1チャネル 
ADC 2つの 12ビット, シーケンサ

付き 1 MSPS SAR ADC 
10ビット, 16.8 kspsシングルス
ロープ ADC 

オペアンプ (プログラム可能)  4 なし 
コンパレータ (ウェイクアップ機能
付き) 

2 2 

IDAC8 2つの 7ビット 2つの 7ビット 
スマート I/Oポート 2 2 
電源電圧範囲 1.71 V～5.5 V 1.71 V～5.5 V 
低消費電力
モード 

ディープスリープ 1.3 µA 2.5 µA 
ハイバネート 150 nA NA 
ストップ 20 nA NA 

セグメント LCD駆動 4 COM 8 COM 

                                                                    
8 IDACは、CAPSENSE™が使用されていない場合にのみ使用できます。詳細については、それぞれの PSoC™4アーキテクチャ

TRMを参照してください。 

http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-042
https://www.cypress.com/documentation/development-kitsboards/psoc-4-cy8ckit-146-4xxx-prototyping-kits
https://www.cypress.com/documentation/development-kitsboards/psoc-4-cy8ckit-146-4xxx-prototyping-kits
https://www.cypress.com/documentation/development-kitsboards/psoc-4-cy8ckit-146-4xxx-prototyping-kits
http://www.cypress.com/CY8CKIT-044
http://www.cypress.com/CY8CKIT-044
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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特長 PSoC™ 4500S PSoC™ 4700S 
プログラム可能 I2C, SPI, または
UART付き SCB 

5 2 

TCPWM 8 5 
モーター制御アクセラレーション 
(MCA) 

2 なし 

クロック IMO 24 MHz～48 MHz 24 MHz～48 MHz 
ILO 40 kHz 40 kHz 
WCO 32 kHz 32 kHz 
ECO 4 MHz～33 MHz なし 

電源監視 POR, BOD POR, BOD 
対応するキット CY8CKIT-045S pioneer kit CY8CKIT-148 evaluation kit 
対応する IDE PSoC™ Creator PSoC™ Creator 

https://www.cypress.com/documentation/development-kitsboards/psoc-4500s-pioneer-kit-cy8ckit-045s
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-148-psoc-4700s-inductive-sensing-evaluation-kit
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
https://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
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4 PSoC™が MCUより優れている点 
Figure 10は標準的な MCUを示し、CPU (8051または Arm® Cortex®など) および ADC, DAC, UART, SPI等の
ペリフェラル機能および汎用 I/Oを含みます。これらはすべて CPUのレジスタ インターフェースにリン
クします。MCU内で、CPUはデバイスの 「心臓」です。CPUはセットアップ, データ移動, タイミングな
どをすべての処理を管理します。CPUなしでは、MCUは機能しません。 

Figure 11に示すように、PSoC™はまったく違います。PSoC™では、CPU, アナログ, デジタル, および I/O
は、プログラマブルなシステムで同等に重要なリソースです。PSoC™の心臓はシステムの相互接続とプ
ログラマビリティであり、CPUではありません。ペリフェラル アナログとデジタルは高度に設定可能な
信号マトリックスおよびデータ バス メッシュを介して相互接続します。これにより、ユーザーがアプ
リケーション要件を満たすカスタム設計を作成可能にします。PSoC™をプログラムして MCUをエミュレ
ートできますが、MCUをプログラムして PSoC™をエミュレートできません。  

 

Figure 10 標準的な MCUのブロックダイヤグラム 
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Figure 11 PSoC™のブロックダイヤグラム 

標準的な MCUは、ステート マシンを処理し、タイマーをタイミングに使用し、出力ピンを駆動するた
めに、CPUファームウェアを必要とします。したがって、機能的なパスはほとんどの場合が CPUを介し
ます。しかし、PSoC™では非同期の平行処理が可能です。PSoC™を設定し、CPUから独立して動作する
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要素を取得できます。このアプリケーション ノートに組み込まれるプロジェクトはこの概念を示しま
す。PSoC™は CPUにコードを書かずに LEDを点滅させるように設定されます。 

4.1 PSoC™ Creatorコンポーネントのコンセプト 
PSoC™のその他の重要な点は PSoC™ Creator IDEの使用可能性です。PSoC™ Creatorでは、異なる PSoC™
リソースは設計を迅速にビルドするために、回路図にドラッグ アンド ドロップできるコンポーネント
と呼ばれているグラフィック要素として構成されます。すべての PSoC™のペリフェラルは、検証済み
PSoC™ Creatorコンポーネント (PWMコンポーネント、ADCコンポーネント、DACコンポーネント、
CAPSENSE™コンポーネント、UARTコンポーネントなど) として使用できます。PSoC™ Creatorの検証済
みコンポーネントの使用可能性は開発時間を著しく短縮します。それにより、グラフィック オプション
を用いて、設計も迅速に変更できます。 

例えば、標準的なマイクロコントローラーで PWMを設定し、LEDを点滅させることは以下のことを含
みます。 

1. PWMブロックに対応したレジスタの位置付け 
2. 要求される PWM周期およびデューティ比に基づいて、PWMレジスタに書き込む値を計算 
3. PWMレジスタを設定するために数多くのコード ラインを書き、ピン駆動モードを設定し、PWM出力
をピンに接続。数多くの MCUは内部ブロックに接続するために、代わりのピンは提供しない 

PSoC™での同じ機能の実装は、本アプリケーション ノートの後半で説明する簡単な操作です。これか
ら、タイマーに同じ PWMブロックを再設定する場合は、PSoC™ Creatorではわずかなマウス クリックだ
けで、それ以上に手間がかかりません。 

PSoC™には、ユニバーサル デジタル ブロック (UDB) として知られるプログラマブル デジタル ブロック
もあります。PSoC™ Creatorはまた、UART、SPI、I2S、タイマー、PWM、カウンター、デジタル ゲート 
(AND、OR、NOT、XOR) など、UDBからなる様々なコンポーネントを提供します。PSoC™ Creatorで UDB
を使用し、自分のカスタム ステート マシンおよびデジタル ロジックを作り上げられます。カスタム
PSoC™ Creatorコンポーネントの作成方法は PSoC™ Creator™ Component author guideを参照してくだ
さい。 

http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-author-guide
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5 ModusToolbox™を使用するはじめての PSoC™ 4設計 
ここでは、 

• 従来の MCU以上のことを行うように PSoC™をプログラムする方法を示します。 
• 単純な PSoC™アプリケーションを構築し、それを開発キットにプログラムする方法を示します。 
• ModusToolbox™に Eclipse IDEを使用するための詳細な手順を提供します。 

ただし、ModusToolbox™ソフトウェアは IDEに依存しません。ここの手順では、ModusToolbox™用の
Eclipse IDEを使用して、Project Creatorを起動します。結果のプロジェクトは自動的に IDEにインポート
されます。 

Linux, macOS, または Windowsでは、Project Creator, Library Manager, および任意の Configuratorをスタン
ドアロンツールとして使用できることに注意してください。これらのツールは、アプリケーションフォ
ルダー内のファイルを作成または変更します。コマンドラインから、そのアプリケーションを、VS 
Code, IAR Embedded Workbench, Keil µVisionなどのサポートされているサードパーティの IDEにエクスポ
ートできます。Eclipse IDEの使用は必須ではありません。詳細については、ModusToolbox™ user guide
の「IDEへのエクスポート」を参照してください。 

5.1 インストールの前に 

5.1.1 ModusToolbox™をインストールしましたか？ 
ModusToolbox™ホームページから ModusToolbox™をダウンロードしてインストールしてください。ソ
フトウェアをインストールした後、ModusToolbox™ IDEのクイックスタートガイドとユーザーガイドを
参照して、ソフトウェアの概要を確認してください。 

5.1.2 開発キットまたはプロトタイピングキットはありますか？ 
この設計をテストするためには、プログラマが統合された、Table 7にリストされているキットの 1つ
が必要です。 

Table 7 PSoC™ 4パイオニアキット、プロトタイピングキット、およびサポートされているデ
バイスのリスト 

キット名 キット形式 対応するデバイスファミリ 製品番号 
CY8CKIT-145 プロトタイピングキット PSoC™ 4000S CY8C4045AZI-S413 
CY8CKIT-041-41XX パイオニアキット PSoC™ 4100S CY8C4146AZI-S433 
CY8CKIT-149 プロトタイピングキット PSoC™ 4100S Plus CY8C4147AZI-S475 
CY8CKIT-041S-Max パイオニアキット PSoC™ 4100S Max CY8C4149AZI-S598 

5.2 これらの手順の使用 
これらの手順は、いくつかのセクションにグループ化されています。各セクションでは、アプリケーシ
ョン開発ワークフローのフェーズについて説明します。主なセクションは次のとおりです。 

• パート 1: 新しいアプリケーションの作成 
• パート 2: 設計の参照と変更 
• パート 3: ファームウェアの書き込み 
• パート 4: アプリケーションの作成 
• パート 5: デバイスのプログラム 

https://www.cypress.com/products/modustoolbox
https://www.cypress.com/ModusToolboxUserGuide
https://www.cypress.com/ModusToolboxUserGuide
https://www.cypress.com/products/modustoolbox-software-environment
http://www.cypress.com/cy8ckit-145
https://www.cypress.com/documentation/development-kitsboards/cy8ckit-041-41xx-psoc-4100s-capsense-pioneer-kit
http://www.cypress.com/cy8ckit-149
https://www.cypress.com/documentation/development-kitsboards/psoc-4100s-max-pioneer-kit-cy8ckit-041s-max
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• パート 6: 設計のテスト 

この設計は、Table 7にリストされているキット用に開発されています。アプリケーションの作成中に
適切なキットを選択することにより、この例をテストできます。 

5.3 設計について 
この設計では、PSoC™ 4の CM0+ CPUを使用して、UART通信と LED制御の 2つのタスクを実行します。
CM0+ CPUは UARTを使用して「Hello World」メッセージをシリアルポートストリームに出力し、キット
のユーザーLEDの点滅を開始します。 

5.4 パート 1: 新しいアプリケーションの作成 
ここでは、新しいアプリケーションを作成するためのステップバイステップのプロセスについて説明し
ます。「Empty PSoC™4 App」スターターアプリケーションは、設計開発段階とプログラミングをガイ
ドするために使用されます。 

ModusToolbox™を使用したプロジェクトの開発に精通している場合は、「Hello World」スターターアプ
リケーションを直接使用できます。詳細については、サンプルコードを参照してください。このスター
ターアプリケーションは完全な設計であり、サポートされているキット用にファームウェアが作成され
ています。手順を確認し、サンプルコードで手順がどのように実装されているかを確認できます。 

最初から始めてこのアプリケーションノートの指示に従う場合でも、サンプルコードを参照として使用
できます。 

ModusToolbox™を起動して開始します。ModusToolbox™は、スターターアプリケーションをマシンに正
常に複製するために、インターネットにアクセスする必要があることに注意してください。 

5.4.1 新しい workspace (ワークスペース) の選択 
ModusToolbox™を起動すると、ワークスペースのディレクトリを選択できるダイアログが表示されま
す。ワークスペースディレクトリは、ワークスペースの設定と開発成果物を保存するために使用されま
す。Browseをクリックして、既存の空のディレクトリを選択してください。または、完全なパスとと
もにディレクトリ名を入力すると、ModusToolbox™によってディレクトリが作成されます。 
 

 

Figure 12 ワークスペースのディレクトリの選択 
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5.4.2 新しい ModusToolbox™アプリケーションの作成 
a) Quick Panelの Startグループで New Applicationをクリックしてください。 
b) または、File > New > ModusToolbox Applicationを選択してください。 

ModusToolbox™ IDE applicationウィンドウが表示されます。 
 

A

B

 

Figure 13 新しい ModusToolbox™ IDEアプリケーションの作成 

5.4.3 ターゲット PSoC™ 4開発キットの選択 
ModusToolbox™は、新しいアプリケーションダイアログで指定された開発キットのさまざまなワークス
ペース/プロジェクトオプションを設定する BSPを提供することにより、開発プロセスをスピードアッ
プします。 

a) Choose Board Support Package (BSP)ダイアログで、Kit Nameを選択してください (例えば CY8CKIT-
041S-MAX) 。 
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b) Nextをクリックしてください。 
 

A

B

 

Figure 14 ターゲットハードウェアの選択 

c) Select Applicationダイアログで、Empty PSoC™4 Appテンプレートアプリケーションを選択してくだ
さい。 

d) New Application Nameフィールドに、Hello_Worldなどのアプリケーションの名前を入力してくだ
さい。デフォルトの名前を保持することもできます。 

e) Createをクリックしてください。ModusToolbox™はアプリケーションプロジェクトを作成します。 
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Figure 15 スターターアプリケーションの選択 

これで、PSoC™ 4用の新しい ModusToolbox™アプリケーションが正常に作成されました。 

BSPは、選択したキットに基づいて、Table 7にリストされているデバイスを使用します。 

PSoC™ 4に基づくカスタムハードウェア、または別の PSoC™ 4製品番号を使用している場合は、
ModusToolbox™ user guideを参照してください。このガイドは、ModusToolbox™インストールディレク
トリの ide_2.2>docsフォルダにもあります。 

5.5 パート 2: 設計の参照と変更 

5.5.1 プロジェクト構成 
Figure 16に、アプリケーションプロジェクトの構造を表示する ModusToolbox™プロジェクトエクスプ
ローラーを示します。 

ModusToolbox™ IDEでは、PSoC™ 4アプリケーションは CM0+ CPUのコードを開発するプロジェクトで
構成されます。 

a) プロジェクトフォルダはさまざまなサブ フォルダで構成され、それぞれがプロジェクトの特定の側面
を示します。 

b) ビルドフォルダには、プロジェクトの makeビルドから生じるすべてのアーティファクトが含まれま
す。出力ファイルは、ターゲット BSPごとに編成されます。 

https://www.cypress.com/file/504361/download
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c) libsフォルダには、アプリケーションに対してローカルなライブラリがあります。デフォルトでは、
作成されたアプリケーションの BSPはローカルであり、このフォルダで使用できます。これにより、
変更が他のアプリケーションに伝播することを心配せずに、特定のアプリケーションの BSPを変更で
きます。 

d) mtb_sharedフォルダには、異なるミドルウェアに属するサブフォルダ (PSoC™ 4 HAL, PSoC™ 4 PDL, 
CAPSENSE™など) があります。これらは、プロジェクト内で提供される.mtbファイルに基づいてダウ
ンロードされる個々のライブラリです。これらのライブラリは、デフォルトで、ワークスペース内の
プロジェクト間で共有されます。 

e) mtbファイルは、ModusToolbox™がコンテンツをプルする場所を提供します。これらのファイルには
通常、ライブラリ全体の GitHubの場所が含まれます。.mtbファイルは、別の.mtbファイルを含むコ
ンテンツを指すことができます。ModusToolbox™は、このネストされた.mtbファイルを再帰的に処理
し、すべてのライブラリをダウンロードします。 
 
例えば、BSP libファイル TARGET_CY8CKIT-041S-MAX.mtbは、
https://github.com/infineon/TARGET_CY8CKIT-041S-MAX#latest-v1.X。リンク内の latest-v1.Xタグは、
BSPの特定のリリースを示します。 
 
別の例では、capsense.mtbは https://github.com/Infineon/capsense#latest-v3.Xでホストされるライ
ブラリを指します。 

f) アプリケーションプロジェクトには Makefileが含まれていることに注意してください。これには、プ
ロジェクトを再作成する方法の説明があります。このファイルには、makeツールがアプリケーショ
ンプロジェクトをコンパイルおよびリンクするために使用する一連のディレクティブも含まれます。 

https://github.com/Infineon/TARGET_CY8CKIT-041S-MAX#latest-v1.X
https://github.com/Infineon/capsense#latest-v3.X
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Figure 16 プロジェクトエクスプローラー外観 

g) BSPによって提供されるファイルは、libsフォルダの TARGET_xフォルダの下にリストされていま
す。デバイスおよび周辺コンフィギュレーターによって生成されたすべての設定ファイルは、BSP
の COMPONENT_BSP_DESIGN_MODUS / GeneratedSourceフォルダに含まれ、接頭辞 cycfg_が付けられ
ます。これらのファイルには、BSPによって定義された設計設定が含まれます。 design.modusファ
イルをダブルクリックして、デザイン設定を表示してください。 
 
BSPフォルダには、プロジェクトで使用されるミドルウェアとその他のライブラリを指定する deps
フォルダ内の.libファイル、およびボードで使用される PSoC™ 4デバイスのリンカースクリプトと
起動コードも含まれます。 
 
Figure 17に、このワークスペースの BSPファイルを含む libsフォルダの構造を表示する
ModusToolbox™プロジェクトエクスプローラーを示します。 
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Figure 17 プロジェクトエクスプローラー外観 - 展開された libs/TARGET_xフォルダ 

5.5.2 設計の変更 
1. libs>TARGET_X>COMPONENT_BSP_xフォルダから design.modusファイルをダブルクリックしてくださ
い。 
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Figure 18 design.modusファイルを開く 

これにより、Device Configuratorダイアログが開きます。他の design.xファイルをダブルクリックして
それぞれのコンフィギュレーターで開くか、Quick Panelの対応するリンクをクリックして必要に応じ
て設定することもできます。 



  

 

Application Note 37 of 64 001-89249 Rev. *J  
  2021-12-23 

PSoC™ 4入門 
  
ModusToolbox™を使用するはじめての PSoC™ 4設計 

  

 

Resources 
Categories Pane

List of 
Resources

Notices Pane

Code Preview 
Pane

Parameters Pane

 

Figure 19 design.modusの概要 

Device Configuratorダイアログの Resources Categoryペインから、デバイスで使用可能な周辺機器、ピ
ン、クロックなどのさまざまなリソースから選択できます。Peripheralタブには、デバイスで使用可能
な List of Resourceのリストが表示されます。 

Personalityは、リソースの動作を定義します。たとえば、Serial Communication Block (SCB) リソース
には、EZI2C, I2C, SPI, または UARTパーソナリティを含めることができます。Name(s)フィールドは、フ
ァームウェア開発で使用されるリソースの名前です。1つ以上の名前をコンマで区切って指定できます 
(スペースなし) 。 

Parameterペインで、有効な各リソースおよび選択したパーソナリティの構成パラメーターを入力でき
ます。Code Previewペインには、選択した設定パラメーターに対して生成された設定コードが表示され
ます。このコードは、GeneratedSourceフォルダの cycfg_ファイルに入力されます。設定に起因するエラ
ー, 警告, および情報メッセージは、Noticesペインに表示されます。 

アプリケーションプロジェクトには、CM0+ CPU (main.c) 用のアプリケーションの作成に役立つ関連ファ
イルが含まれます。この Cファイルは、通常のビルドプロセスの一部としてコンパイルされ、CM0+イメ
ージにリンクされます。 
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2. ResourceCategoriesペインの Peripheral-Clocksタブに移動して、UARTコンポーネントのクロックを
設定してください。 

 

 

Figure 20 クロックの設定 

3. Resource Categoriesペインの Peripheralsタブに移動し、Serial Communication Block (SCB) 1を有効に
して、パーソナリティを UART-1.0に設定し、名前を CYBSP_UARTにしてください。Figure 21では、
キットに必要な Rx/Txピンに基づいて SCBインスタンス 1が選択されています。各インスタンスで
使用可能なピンについては、デバイスデータシートを参照してください。 

 

 

Figure 21 UARTとして SCBの有効化 

https://www.cypress.com/search/all?f%5B0%5D=meta_type%3Atechnical_documents&f%5B1%5D=resource_meta_type%3A575&f%5B2%5D=field_related_products%3A1297
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4. Parameterペインで、Clock、Rx、および Txなどの必要な設定パラメーターを設定してください。
他のパラメーターのデフォルト値を保持してください。 

 

 

Figure 22 UART設定パラメーターの設定 

5. Code Previewペインに移動して、生成されたコードをプレビューしてください。 
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Figure 23 コードプレビューペイン 

6. Resource Categoriesペインの Pinsタブに移動して、キットのユーザーLEDが点滅するように GPIO
を構成してください。別の PSoC™ 4キットを使用している場合は、Table 8を参照してください。 
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Figure 24 GPIOの設定 

Table 8 PSoC™ 4キット全体のピンマッピング表 

機能 CY8CKIT-145 
(PSoC™ 4000S) 

CY8CKIT-041-41XX 
(PSoC™ 4100S) 

CY8CKIT-149 
(PSoC™ 4100S Plus) 

CY8CKIT-041S-MAX 
(PSoC™ 4100S Max) 

ユーザーLED P2[5] P3[4] P3[4] P7[3] 
7. Resource Categoriesペインのさまざまなタブに移動して、他のリソースを表示および設定してくだ
さい。この設計では、これ以上の変更は必要ありません。 

8. パス File → Saveに従うか、[Ctrl]+[S]を押して構成を保存し、GeneratedSourceフォルダにソースコ
ードを生成してください。 

Note: ほとんどの場合、アプリケーションで実際の設計作業を行う前に、デバイスまたはボー
ドの BSPを作成する必要があります。これにより、独自のカスタムハードウェアまたは
さまざまなリンカーオプションの設定を構成できます。また、将来のアプリケーション
で使用するために BSPを保存することもできます。詳細については、  ModusToolbox™ 
user guideCreating a BSP for Your Boardを参照してください。 

https://www.cypress.com/file/504361/download
https://www.cypress.com/file/504361/download
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5.6 パート 3: ファームウェアの書き込み 
この設計では、PSoC™ 4の CM0+ CPUを使用して、UART通信と LED制御の 2つのタスクを実行します。
CM0+ CPUは、UARTを使用して「Hello World」メッセージをシリアルポートストリームに出力し、キッ
トのユーザーLEDを点滅させます。 

Empty PSoC™ 4スターターアプリケーションを使用している場合は、ここで提供されているプログラム
コードからアプリケーションプロジェクトのmain.cファイルにそれぞれのソースコードをコピーできま
す。Hello Worldサンプルコードを使用している場合、必要なファイルはすでにアプリケーションにあ
ります。 

5.6.1 ファームウェアフロー 
ここでは、アプリケーションのmain.cファイルのコードについて説明します。 

この例では、CM0+ CPUがリセットから抜け出し、リソースの初期化を実行します。システムクロック, 
ピン, クロックから周辺機器への接続, およびその他のプラットフォームリソースを設定します。 

クロックとシステムリソースは、BSP初期化関数によって初期化されます。PDL関数は、UARTコンポー
ネントを構成して有効にするために使用されます。UARTは、ターミナルエミュレータに「Hello 
World」メッセージを出力します。オンボードの KitProg3は、仮想 COMポートを作成するための USB-
UARTブリッジとして機能します。ソフトウェア遅延を伴う無限 FORループは、ユーザーLEDを定期的
に切り替えるために使用されます。 

アプリケーションコードは、BSP/PDL関数を使用して目的の機能を実行することに注意してください。 

• cybsp_init() - この BSP関数は、システムクロックと電力レギュレーターを含みますが、これらに
限定されないデバイスのシステムリソースを初期化します。 

• Cy_SCB_UART_Init() - この PDL関数は、UART操作用に SCBブロックを初期化します。設定構造
CYBSP_UART_configは、UARTを構成するためのこの関数のパラメーターとして使用されます。こ
の構造は、適用された構成に基づいて design.modusによって自動生成されます。 

• Cy_SCB_UART_Enable() - この PDL関数は、UART操作の SCBブロックを有効にします。 
• Cy_SCB_UART_PutString() - この PDL関数は、NULLで終了する文字列を UART TX FIFOに配置し
ます。 

• Cy_GPIO_Inv() - この PDL関数は、ピン出力ロジック状態を現在の出力ロジック状態の逆に設定し
ます。 

• Cy_SysLib_Delay() - この PDL関数は、指定されたミリ秒数だけ遅延します。 

Code Listing 1をアプリケーションプロジェクトの main.cにコピーしてください。 

Code Listing 1 プログラムコード main.c 

#include "cy_pdl.h" 
#include "cybsp.h" 
 
 
/**************************************************************************
***** 
* Macros 
***************************************************************************
****/ 
#define LED_DELAY_MS             (500u) 
#define CY_ASSERT_FAILED         (0u) 
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/**************************************************************************
***** 
* Function Name: main 
***************************************************************************
***** 
* Summary: 
*  System entrance point. This function performs 
*  - initial setup of device 
*  - configure the SCB block as UART interface 
*  - prints out "Hello World" via UART interface 
*  - Blinks an LED under firmware control at 1 Hz 
* 
* Parameters: 
*  none 
* 
* Return: 
*  int 
* 
***************************************************************************
****/ 
int main(void) 
{ 
    cy_rslt_t result; 
    cy_stc_scb_uart_context_t CYBSP_UART_context; 
 
    /* Initialize the device and board peripherals */ 
    result = cybsp_init(); 
 
    /* Board init failed. Stop program execution */ 
    if (result != CY_RSLT_SUCCESS) 
    { 
        CY_ASSERT(CY_ASSERT_FAILED); 
    } 
 
    /* Configure and enable the UART peripheral */ 
    Cy_SCB_UART_Init(CYBSP_UART_HW, &CYBSP_UART_config, 
&CYBSP_UART_context); 
    Cy_SCB_UART_Enable(CYBSP_UART_HW); 
 
    /* Enable global interrupts */ 
    __enable_irq(); 
 
    /* Send a string over serial terminal */ 
    Cy_SCB_UART_PutString(CYBSP_UART_HW, "Hello world\r\n"); 
 
    for(;;) 
    { 
        /* Toggle the user LED state */ 
        Cy_GPIO_Inv(CYBSP_USER_LED1_PORT, CYBSP_USER_LED1_PIN); 
 
        /* Wait for 0.5 seconds */ 
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        Cy_SysLib_Delay(LED_DELAY_MS); 
    } 
} 

 

 

Figure 25 ファームウェアフローチャート 

これは、サンプルコードでファームウェアがどのように機能するかをまとめたものです。理解を深める
ために、ソースファイルを調べてください。 

5.7 パート 4: アプリケーションの作成 
ここでは、アプリケーションを構築する方法を示します。 

5.7.1 アプリケーションのビルド 
a) Project Explorerウィンドウでアプリケーションプロジェクトを選択し、Quick Panelの<name>グル
ープの下にある Build <name> Applicationショートカットをクリックしてください。これによって
Debug build configurationが選択され、アプリケーションを構成するすべてのプロジェクトがコン
パイル/リンクされます。 

b) Consoleビューには、ビルド操作の結果が一覧表示されます。 

Start

Initialize Clocks and 
System Resources

Initialize and Enable 
SCB UART Block

Print  “Hello World” 
onto UART Terminal

Toggle LED/GPIO 
State

Delay 500 ms
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Figure 26 アプリケーションのビルド 

エラーがある場合は、手順をチェックして、必要なタスクが完了していることを確認してください。 

Note: CLIを使用してもアプリケーションをビルドできます。ModusToolbox™ user guideの
Running ModusToolbox from the Command Lineの実行を参照してください。このドキュメ
ントは、ModusToolbox™インストールディレクトリの/ide_2.2/docs/フォルダにあります。 

5.8 パート 5: デバイスのプログラム 
ここでは、PSoC™ 4デバイスをプログラムする方法を示します。 

ModusToolbox™は、SWDプロトコルを使用して、PSoC™ 4デバイス上のアプリケーションをプログラム
およびデバッグします。ModusToolbox™がキット上のデバイスを識別するためには、キットで KitProg3
が実行されている必要があります。一部のキットには、KitProg3ではなく KitProg2ファームウェアが付
属します。ModusToolbox™には、KitProgファームウェアを KitProg2から KitProg3に切り替えるための
fw-loaderコマンドラインツールが含まれます。詳細は、ModusToolbox™ IDE user guideの KitProg 
Firmware Loaderセクションを参照してください。 

https://www.cypress.com/file/512716/download
https://www.cypress.com/file/504371/download
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自分でハードウェアを開発している場合は、ハードウェアプログラマー/デバッガが必要になる場合があ
ります。例えば、CY8CKIT-005 MiniProg4です。 

5.8.1 アプリケーションのプログラム 
a) キットを PCに接続してください。 
b) アプリケーションプロジェクトを選択し、クイックパネルの Launchesグループの下にある

<aaplication name> Program (KitProg3_MiniProg4) ショートカットをクリックしてください。IDE
は、適切な実行構成を選択して実行します。最後のビルド以降にファイルが変更されている場
合、このステップでもビルドが実行されることに注意してください。 

 

 

Figure 27 デバイスへのアプリケーションのプログラム 

コンソールビューには、プログラミング操作の結果が一覧表示されます。 

https://www.cypress.com/documentation/development-kitsboards/cy8ckit-005-miniprog4-program-and-debug-kit
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Figure 28 コンソール - プログラミング結果 

5.9 パート 6: 設計のテスト 
ここでは、設計をテストする方法について説明します。 

次の手順に従って、設計の出力を観察してください。このアプリケーションノートでは、結果を表示す
るための UARTターミナルエミュレータとして Tera Termを使用します。任意の端末を使用して出力を
表示できます。 

5.9.1 シリアルポートの選択 
Figure 29に示すように、Tera Termを起動し、USB-UART COMポートを選択してください。COMポート
番号は異なる場合があることに注意してください。 
 

 

Figure 29 Tera Termでの KitProg3 COMポートの選択 
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5.9.2 ボーレートの設定 
Setup > Serial portへ移動してください。ボーレートを 115200に設定してください。 
 

 

Figure 30 Tera Termでのボーレートの設定 

5.9.3 デバイスのリセット 
キットのリセットスイッチ (SW1) を押してください。「Hello World」メッセージが端末に表示されま
す。キットのユーザーLEDが点滅し始めます。 
 

 

Figure 31 PSoC™ 4からプリントされた UARTメッセージ 
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6 PSoC™ Creatorを使用するはじめての PSoC™ 4設計 
ここでは以下を説明します。 

• 従来の MCU以上のことができるように PSoC™をプログラムするデモンストレーション 
• 単純な PSoC™の設計をビルドし、それを開発キットにインストールする方法の提示 
• PSoC™設計技術の学習を容易にする詳細な手順と、PSoC™ Creatorの使用方法の提示 

6.1 インストールの前に 

6.1.1 PSoC™ Creatorをインストールしましたか? 
PSoC™ Creatorホームページから PSoC™ Creatorをダウンロードし、インストールします。ツールセッ
トのインストールは時間がかかることに注意してください。詳細については PSoC™ Creatorリリース ノ
ートを参照してください。 

6.1.2 開発キットまたは Prototyping Kitをお持ちですか? 
この設計のテストにはプログラマを搭載する Table 9に示すキットの 1つが必要です。 

Table 9 PSoC™ 4 Pioneer Kit, Prototyping Kitおよび対応するデバイスの一覧 

キット名 キットタイプ 対応するデバイスファミリ 製品番号 
CY8CKIT-040 Pioneer kit PSoC™ 4000 CY8C4014LQI-422 
CY8CKIT-041 Pioneer kit PSoC™ 4100S CY8C4146AZI-S433 

CY8CKIT-042 Pioneer kit PSoC™ 4200 CY8C4245AXI-483 
CY8CKIT-044 Pioneer kit PSoC™ 4200M CY8C4247AZI-M485 
CY8CKIT-046 Pioneer kit PSoC™ 4200L CY8C4248BZI-L489 

CY8CKIT-042-BLE Pioneer kit PSoC™ 4200 Bluetooth® LE CY8C4247LQI-BL483 
CY8CKIT-045S Pioneer kit PSoC™ 4500S CY8C4548AZI-S485 
CY8CKIT-043 Prototyping kit PSoC™ 4200M CY8C4247AZI-M485 

CY8CKIT-145 Prototyping kit PSoC™ 4000S CY8C4045AZI-S413 
CY8CKIT-147 Prototyping kit PSoC™ 4100PS CY8C4145LQI-PS433 

CY8CKIT-149 Prototyping kit PSoC™ 4100S Plus CY8C4147AZI-S475 

6.1.3 実行中のプロジェクトをご覧になりたいですか? 
設計プロセスを実行したくない場合は、PSoC™ Creatorで Find Code Example (File > Code Example… >  
CE230991_My_First_Project) を使用して、完成した PSoC™ Creatorプロジェクトを取得できます。詳細
については、サンプルコードを参照してください。その後、ビルドとプログラムのステップにジャン
プできます。 

6.2 設計について 
Figure 32に示すように、この設計は TCPWMコンポーネントを使用し、単純に 2個の LEDを点滅させま
す。TCPWMは PWMモードとして設定されます。PWMの 2個の相補出力は LEDを制御します。PWMは
LEDのトグルが見えるように、非常に低い周波数と 50パーセントのデューティ比で動作します。2個の
個別の LEDの代わりにデュアル カラーLEDを使用すると、このプロジェクトはデュアル カラーLEDの色
をトグルできます。 

http://www.cypress.com/go/creator
http://www.cypress.com/CY8CKIT-040&source=an79953
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-044
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
https://www.cypress.com/documentation/development-kitsboards/psoc-4500s-pioneer-kit-cy8ckit-045s
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-043-psoc-4-m-series-prototyping-kit
http://www.cypress.com/cy8ckit-145
http://www.cypress.com/cy8ckit-147
http://www.cypress.com/cy8ckit-149
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Figure 32 はじめての PSoC™ 4設計 

6.3 パート 1: 設計の作成 
ここでは設計プロセスの概要について順に説明します。空のプロジェクトを作成し、ハードウェアとフ
ァームウェア設計入力について解説します。 

1. Figure 33に示すように、PSoC™ Creatorを起動し、Fileメニューから New > Projectを選択してくだ
さい。 

 

 

Figure 33 新規プロジェクトの作成 

2. ポップアップ ウィンドウで開発キットを選択してください。例えば、CY8CKIT-149をお持ちの場合、
Kit: CY8CKIT-149 (PSoC™ 4100S Plus) を選択し、Nextをクリックしてください。メニューにお持ちの
PSoC™ 4開発キットがない場合、ウェブサイトからキット セットアップをダウンロードし、インス
トールしてください。 
 
または、ターゲット ハードウェアの代わりに、ターゲット デバイス ラジオ ボタンを選択して適切な
デバイスを選んで、Nextをクリックすることもできます。 
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Figure 34 空の PSoC™ 4新規プロジェクトの作成 

3. 次のウィンドウから Empty schematicオプションを選択し、Nextをクリックしてください。 
 

 

Figure 35 Empty schematicの選択 

4. Figure 36に示すように、プロジェクト名 (例えば「My_First_Project」) およびワークスペース名をつ
けてください。新規プロジェクトに適切な場所を選択して、Finishをクリックしてください。 
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Figure 36 プロジェクト名と場所の選択 

5. Workspace Explorer (Figure 37を参照) に示すように、新規プロジェクトを作成すると、ファイルの
ベースライン セットを含むプロジェクト フォルダが作成されます。TopDesign.cyschをダブルクリッ
クし、プロジェクトの回路図ファイルを開いてください。 

 

 

Figure 37 TopDesign回路図を開く 

6. Figure 38に示すように、Component Catalogから回路図に 1つの PWM (TCPWM mode) コンポーネン
トをドラッグしてください。 
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Figure 38 PWMコンポーネントの配置 

7. Figure 39に示すように、回路図の PWMコンポーネントをダブルクリックし、コンポーネントのプロ
パティを設定してください。PWMタブをクリックして、デューティ比が 50パーセントの PWM信号
を生成するために、周期値を 254に比較値を 127にセットしてください。 
 
入力クロック周波数を 8で分周するために、Prescalerを 8xにセットしてください。 

 

 

Figure 39 PWMコンポーネントの設定 
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8. PWMコンポーネントが動作するために 1つの入力クロックを必要とします。Figure 40と Figure 41
に示すように、回路図に Clockコンポーネントをドラッグ アンド ドロップし、そのコンポーネント
をダブルクリックして、Frequencyを 800 Hzに設定してください。PWMコンポーネントの Prescaler
値設定が 8なので、PWMの実効入力クロックはわずか 100 Hzです。したがって、PWM周期が 254の
場合、PWM出力周期時間は 2.54秒になります。 

 

 

Figure 40 クロック コンポーネントの場所 

 

 

Figure 41 クロック コンポーネントの設定 
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9. Digital Output Pinコンポーネントをドラッグ アンド ドロップしてください。Figure 42と Figure 43
に示すように、その名前を LED_1に変更してください。他のデジタル出力ピン コンポーネントを追
加して、LED_2と名付けてください。 

 

 

Figure 42 デジタル出力ピン コンポーネントの場所 

 

 

Figure 43 ピン コンポーネントの再名付け 
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10. 回路図ウィンドウで、Figure 44に示すように、ワイヤー ツールを選択、またはWを押してくださ
い。 

 

 

Figure 44 ワイヤー ツールの選択 

11. Figure 45に示すように、コンポーネントを一緒に配線してください。 
 

 

Figure 45 回路図の配線 

12. ほとんどのコンポーネントはデバイス リセットで無効になります。クロック コンポーネントは重要
な例外で、デフォルトで自動的に起動されます。これらのコンポーネントを有効にするように、プ
ロジェクトにコードを追加する必要があります。Workspace Explorerから main.cを開き、Code 
Listing 2のように、コードを main()関数に追加してください。 

Code Listing 2 PWMコンポーネントの有効化 

int main(void) 
{ 
  /* Enable and start the PWM */ 
  PWM_1_Start(); 
 
  for(;;) 
  { 
 
  } 

} 
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13. ビルド メニューから Build My_First_Projectを選択してください。Figure 46に示すように、
Workspace Explorerウィンドウでは、PSoC™ Creatorが PWM, クロック, およびデジタル出力ピン コン
ポーネントに対しソース コード ファイルを自動的に生成することに注意してください。 

 

 

Figure 46 生成されたソース ファイル 

14. Workspace Explorerから My_First_Project.cydwr (Design-Wide Resourceファイル) ファイルを開き、
Pinsタブをクリックしてください。このタブで LED_1と LED_2出力用のデバイス ピンを選択できま
す。 
 
Figure 47に、CY8CKIT-149 PSoC™ 4 prototyping kitで LED_1と LED_2ピンを LEDに接続するピン コ
ンフィギュレーションを示します。別の PSoC™ 4 Pioneer Kitをお使いの場合は Table 10を、PSoC™ 4 
prototyping kitをお使いの場合は Table 11を参照してください。 

http://www.cypress.com/cy8ckit-149
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Figure 47 ピン選択 

Table 10 Pioneerキットのピン マッピング表 

機能 CY8CKIT-
040 
(PSoC™  
4000) 

CY8CKIT-
041 
(PSoC™  
4100S) 

CY8CKIT-
042 
(PSoC™  
4200) 

CY8CKIT-042-BLE 
(PSoC™ 4200 
Bluetooth® LE) 

CY8CKIT-
044 
(PSoC™  
4200M) 

CY8CKIT-
046 
(PSoC™  
4200L) 

CY8CKIT-
045S 
(PSoC™  
4500S) 

緑色 LED (アク
ティブ LOW) 

P1[1] P2[6] P0[2] P3[6] P2[6] P5[3] P0[0] 

赤色 LED (アク
ティブ LOW) 

P3[2]9 P3[4]10 P1[6] P2[6] P0[6] P5[2] P1[6] 

Table 11 Prototypingキットのピン マッピング表 

機能 CY8CKIT-145 (PSoC™ 4000S) CY8CKIT-149 (PSoC™ 4100S Plus) 
緑色 LED - LED 1 (アクティブ LOW)  P3[4] P1[6] 

緑色 LED - LED 2 (アクティブ LOW) P3[5] P5[7] 

Note: CY8CKIT-043および CY8CKIT-147には、それぞれ P1[6]および P0[2]に接続する LEDが 1つだ
けあります。外部 LEDは、CY8CKIT-043の場合はピン P0[2]に、CY8CKIT-147の場合はピン
P0[3]に接続できます。 

                                                                    
9  PSoC™ 4000製品には、補完的な PWM出力用の固定ピン P1[1]および P1[6]があります。PWM出力に他のピンは使用できませ
ん。詳細については、デバイスのデータシートを参照してください。CY8CKIT-040を使用している場合は、P1[1]に接続する
緑色の LEDを LED1として使用できます。赤色 LEDを LED2として使用するためには、ヘッダーJ4の P3[2]をヘッダーJ3の
P1 [6]にワイヤーで接続します。または、外部 LEDも LED2として P1[6]に接続できます。 

10 上記の注記と同様に、CY8CKIT-041を使用している場合は、P2[6]に接続する緑色の LEDを LED1として使用し、LED2の補完
的な PWM出力 P2[7]を使用できます。赤色 LEDを LED2として使用するためには、ヘッダーJ2の P3[4]をヘッダーJ3の P2[7]
にワイヤーで接続します。または、外部 LEDも LED2として P2[7]に接続できます。 

http://www.cypress.com/?rID=94456&source=an79953
http://www.cypress.com/CY8CKIT-041
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15. 最後に、ステップ 13で説明したようにプロジェクトを再ビルドします。 

6.4 パート 2: デバイスのプログラム 
ここでは、デバイスのプログラム方法を説明します。USBケーブルを使ってキット ボードをコンピュー
ターに接続してください。 

1. Figure 48に示すように、PSoC™ Creatorメニューから、Debug > Select Debug Targetを選択してくだ
さい。 

 

 

Figure 48 デバッグ ターゲットの選択 

2. Figure 49に示すように、Select Debug Targetダイアログボックスで、Port Acquireをクリックして
から、Connectをクリックしてください。OKをクリックし、ダイアログボックスを閉じてくださ
い。 

 

 

Figure 49 デバイスの接続 

3. Figure 50に示すように、Debug > Programを選択し、プロジェクトでデバイスをプログラムしてく
ださい。 
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Figure 50 デバイスのプログラミング 

4. Figure 51に示すように、プログラミングの状態はステータスバー (ウィンドウの左下隅) に表示され
ます。 

 

 

Figure 51 プログラミングの状態 

5. デバイスがプログラムされた後、LEDのトグルをチェックし、プロジェクトの動作を検証してくださ
い。 
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7 まとめ 
本アプリケーション ノートは PSoC™ 4アーキテクチャおよび開発ツールを説明しました。PSoC™ 4は 
単一チップ上に設定可能なアナログとデジタルのペリフェラル機能, メモリ, および Arm® Cortex®-M0/M0+
マイクロコントローラーを集積した真のプログラマブル組込みシステムオンチップです。内蔵された機
能と低リーク電力モードにより、PSoC™ 4は低消費電力とコスト効率が高い組込みシステムに理想的で
す。 

また、本アプリケーション ノートは PSoC™ 4を迅速に深く理解できるように包括的なリソースをご紹介
しました。 
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[1] AN54181: Getting started with PSoC™ 3 

[2] AN77759: Getting started with PSoC™ 5LP 

 

http://www.cypress.com/documentation/application-notes/an54181-getting-started-psoc-3
http://www.cypress.com/documentation/application-notes/an77759-getting-started-psoc-5lp
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